by Cheryl Prentice
© The Writing Center
Saint Mary's University of Minnesota
Schools of Graduate & Professional Programs
Rev. June 2011

INTRODUCTION TO
AMA STYLE, 10th ed.

About This Booklet

FOR NURSE ANESTHESIA

This booklet is not intended to replace the AMA Manual of Style, 10 ed., but
rather to help you interpret the manual and to call your attention to some of its
most important features for student writers. This booklet also provides some
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Throughout the booklet you will see decimal numbers and page numbers that
refer to relevant sections of the AMA manual, where you will usually find more
extensive information. When the manual does not specify a rule, such as
placement of page numbers, your program director and instructors will set a
uniform policy.
At the end of the booklet you will find description of the Saint Mary’s University
Writing Center on the Twin Cities campus, a free service to help you develop
your writing skills. I hope you'll take advantage of the support the Writing Center
offers. You can also find AMA information on the Writing Center's Web page at
www.smumn.edu/tcwrite.
Please note that this booklet is not formatted in AMA style. I have used AMA
style where possible, but AMA was designed for academic papers, not "how-to"
manuals. Consequently, you will see many departures from AMA style and
formatting.
If you want to suggest ways to make the booklet more helpful, I would appreciate
hearing from you. You can reach the Writing Center via the contact information
on the last page.
Cheryl Prentice
Director, The Writing Center
Saint Mary’s University of Minnesota
Schools of Graduate & Professional Programs
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QUICK GUIDE TO THE AMA MANUAL, 10TH ed.
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An index of frequently-referenced passages of the American Medical Association Manual of Style, 10 ed.
Decimal numbers indicate chapter, section, and subsection. For example, 2.12.7 is a reference to Chapter 2, Section 12, subsection 7
ABBREVIATIONS ...................................................... 14.1–14.14
See also specific topic under "Abbreviations" in AMA index

BULLETS (use for lists) ............................................... 2.8.2

Citations in text ..................................................... 3.6
General guidelines .......................................... 3.6
Authors, multiple ............................................. 3.7
Personal communication ................................ 3.13.9
Tables ............................................................. 3.6, p. 42
Works not yet accepted for publication ........... 3.13.8, p. 60

CAPITALIZATION ...................................................... 10.1–10-8

Book references ..................................................... 3.12.1–3.12.11

EPONYMS (terms formed from human names).......... 16.1

HEADINGS ................................................................... 2.8.1–2.8.3
See also 22.5.3-22.5.4

Electronic references ............................................ 3.15–3.15.11
General guidelines .......................................... 3.15
Books.............................................................. 3.15.2
Journals .......................................................... 3.15.1
Reports by government or organization .......... 3.15.5

ITALICS ...................................................................... 22.5.4

Legal references..................................................... 3.15.12–3.16.3

LISTS (Seriation, Enumeration) .............................. 19.5

Monographs (Same as books)

MISPLACED MODIFIERS ............................................ 7.4.1–7.4.2

Other materials references .................................... 3.13–3.14.2

NUMBERS.................................................................. 19.0
Digit spans and hyphens................................. 19.4
Half spaces replacing commas ....................... 19.1.1
Lists (enumeration) ......................................... 19.5
st
nd
Ordinals (1 , first; 2 , second; . . .) ................ 19.2.5
Percentages and proportions .......................... 19.7.2–19.7.3
Spelled out, guide to .................................... 19.2–19.2.5, and 19.3.2

Print journal references ........................................ 3.11–3.11.15

ABSTRACT, Types and contents ................................. 2.5
General guidelines ............................................ 2.5.3

GRAMMAR................................................................... 7.1–7.9

PARALLEL CONSTRUCTION ..................................... 7.7.1–7.7.4
PLURALS ..................................................................... 9.1–9.8
PRONOUNS ................................................................ 7.2
PUNCTUATION ........................................................... 8.0
Apostrophe ....................................................... 8.7.1–8.7.7
Comma, Semicolon, Colon ............................... 8.2–8.2.3
Ellipses (dots to show omission) ....................... 8.8–8.8.8
Hyphen, Dash ................................................... 8.3-8.3.2
REFERENCES and CITATIONS .................................. 3.1-3.16.3
General guidelines for references .................. 3.4–3.5
Author names ................................................ .3.7–3.8
Legal references ............................................ 3.15.12–3.16.2
Secondary sources ........................................ 3.13.10
Titles .............................................................. 3.9-3.10
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Unpublished material references......................... 3.13.8
TABLES & FIGURES ................................................... 4.0
Tables ............................................................... 4.1.1–4.1.9
Figures .............................................................. 4.2.1–4.2.11
TITLES........................................................................ 10.1–10.2
See also
Creating ................................................... 2.1
Figures, Legends, Labels ........................ 4.2.7
Tables...................................................... 4.1.3
References .............................................. 3.9–3.10
Used in text ............................................. 8.6.12 and 22.5.4
USAGE, WORD .......................................................... 11.0
Age and sex referents .................................. 11.5
Bias .............................................................. 11.10-11.10.5
Misused words and phrases ......................... 11.1
Professional words, preferred use ................ 11.4
(See also Nomenclature 12.0)
Redundant words and phrases ..................... 11.2.1
VERBS:Tense .............................................................. 7.3.3
Misplaced modifiers ........................................ 7.4.1-7.4.2
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SUMMARY OF AMA STYLE and Other Writing Tips
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With references to The American Medical Association Manual of Style, 10 ed.

PUNCTUATION and How to Type It
Apostrophe (')

Avoid the misuse of apostrophes.

To Show Ownership or Possession



(a) Add an apostrophe and an s ('s) to words that don't end
with an s.

Wrong: All the player's knew this was the last chance to score
Right: All the players knew this was the last chance to score.

somebody's car (the car belonging to somebody)
the men's locker room (the locker room of the men)
a month's rent (the rent of a month)



all the students' tests (that is, tests belonging to the students)
twelve days' pay (that is, the pay for twelve days

 Correct an especially troublesome error.

(c) To show joint possession, add an apostrophe and s to only the
last word in the group.

It’s (a contraction) means it is: It’s not fair for adults to
compete with children.

Laurel and Hardy's last movie (a movie by the team of Laurel and
Hardy.)

Its (a possessive) means belonging to it:: Henry’s dog chases its
tail.
To test for correctness, ask yourself, “Do I mean it is?”

(d) But to show individual possession, add an apostrophe and s to
each word in the group.

Colon (:) [AMA 6.2.3]

 Use to introduce if list if a complete sentence precedes the list.

The medical students brought the following supplies: tongue
depressors, stethoscopes, gloves, masks, and pens.

To Form the Plural of Lowercase Letters, Signs, Symbols, or Terms
Her e’s look like l’’s.
Underline all the and’’s in your paragraph.
He omitted all the +’s and –‘s in his math problems.

 If a complete sentence does not introduce a list, do not use a colon.
Grading criteria include correct grammar, punctuation, and
spelling as well as adherence to AMA style.

Do not use an apostrophe for plural of all-capital abbreviations or
for numerals.
ECGs, EEGs, IQs
In the late 1880s
Patients in their 50s and 60s

Don't use an apostrophe for pronouns that already indicate
possession.
Wrong: We didn't know the suitcases were her's (your's,
their's, our's).
Right: We didn't know the suitcases were hers (yours,
theirs, ours).

(b) Add only an apostrophe after the s to words that already end in s.

Holm's and Caio's opinions (the opinions of Holm, and the opinions
Caio)

Don't use an apostrophe for a simple plural.

 Colons are used in reference list entries (1) between title and subtitle
and (2) between volume and page numbers of a periodical [see AMA
8.2.3].
Comma (,) [AMA 6.3.1]

Do not use apostrophes to create contractions (eg, cannot =
can’t, do not = don’t). Contractions are generally considered too
informal for academic writing.

 Commas separate words or phrases, but never sentences.
 Comma rules can be flexible, but check the AMA manual before
departing from a rule. Do not use the “rule” of comma-for-a-breath.

 When a comma is used in conjunction with quotation marks, place the
comma inside the end quotation mark—always.
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Six Comma Rules
NOTE: Do not use a comma before a phrase beginning with the word that:

These six comma rules will enable you to punctuate most sentences correctly.
1. Use a comma before a coordinating conjunction (one of the FANBOYS)* if it
joins two sentences.
Ellen thought the movie was exciting, and Fred liked it more than any he had
seen that year.
Fred and Ellen saw a movie and went out to dinner afterwards. (No comma
needed because and is not joining two sentences.

The shoes that Erwin wore to the prom had mildew all over them.
5. Use a comma to set off a phrase at the end of a sentence if that phrase refers to
the beginning, middle, or entire part of the sentence preceding it. These phrases
will usually begin with a word ending in –ed or –ing. *

 In the case of the conjunction “so,”
If the conjunction so is used to join sentences and means therefore,
consequently, or as a result, use a comma before the conjunction:
Dr. Foster had to travel by train, so she arrived too late to give her speech.
But if the conjunction so is used to mean so that, do not use a comma before it.
Elliot stepped in at the last moment so the convention would have a
speaker.
*FANBOYS: For, And, Nor, But, Or, Yet, So (when so means consequently, therefore)
2. Use a comma after introductory expressions. An introductory expression is a
word or words that lead up to the main part of the sentence (independent clause).
Frankly, I've had enough of this cold and rainy weather.
When our bakery closed down, Jan had to buy her bread in Duluth.
Confused by the freeway signs, Ralph got hopelessly lost in Chicago.
3. Use commas to separate three or more items in a series. Use a comma after
each item, including the one before the conjunction.
Harold wore black pants, a red shirt, and an orange tie.
You can study before class, after school, or on Saturday afternoon.
4. Use commas to set off words and phrases that interrupt the sentence if those
words are not essential to the purpose of the sentence.
Michelle took her seat at the table and, much to everyone's surprise, blew her
nose on the tablecloth.
I liked Brad's sense of humor. His lewd jokes, however, deeply embarrassed
his grandmother.
Bill, a man of much courage, grabbed the burglar's hand and bit off his
trigger finger.
Ryan's bedroom, which he hadn't cleaned for nine years, was boarded up by
the county health commissioner.
NOTE: Not all words and phrases need commas. If the phrase is essential to the
main point of the sentence, do not set it with commas.
Students who don't study hard usually get poor grades. (Who don't study hard
is essential to the purpose: to know which students usually get poor grades.)
Dentists who have offices in high-rent locations must charge their patients
high fees.
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Teachers offered rewards to the students, trying to improve their test scores.
With a comma, the sentence means that teachers offered rewards in an attempt to
improve test scores.
Teachers offered rewards to the students trying to improve their test scores.
Without a comma, the sentence means that teachers offered rewards only to students
who were trying to improve their test scores.
Example:
The company recognized every branch manager, raising morale and
encouraging high standards.
The sentence above—containing a comma before the final phrase—means that
raising morale and encouraging high standards are the result of the company’s
recognition of every branch manager. Raising refers to the entire sentence that
precedes it.
The company recognized every branch manager raising morale and
encouraging high standards.
Without a comma, the sentence means that the company recognized only those
branch managers who were raising morale and encouraging high standards.
Example:
Close communication exists among the cell types, allowing interchange of
secretions between the hormones.
The sentence above means that the interchange is a result of the close
communication (among the cell types). Allowing refers to " close communication
exists among cell types.
Close communication exists among the cell types allowing interchange of
secretions between the hormones.
The sentence above means that communication exists only among cell types that
allow the interchange. (Allowing refers only to cell types.)
Example:
Effects on the endothelium increase sensitivity to pressure agents, causing
the vasoconstriction seen in preeclampsia.
Effects on the endothelium increase sensitivity to pressor agents causing the
vasoconstriction seen in preeclampsia.

(Continued)
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6. If rules 1-5 don’t apply, you probably don’t need a comma. Most people overuse commas. Occasionally, however, a comma is needed to prevent the misreading
of a sentence, even if one of the five rules doesn’t apply.

Hyphens and Digit Spans [AMA19.4]

 Do not omit digits in a span: " pp 263-267" (not "pp 263-7"), "19961999" (not 1996-99)

Not, Patients who can discuss side effects with their doctors before undergoing
surgery.
But, Patients who can, discuss side effects with their doctors before undergoing
surgery.

 When using a measurement symbol (such as % or °), and there is
no space between digit and symbol, use a symbol with each digit
[AMA19.4]: 12%-16% (not 12-16%), angles of 45°-60° (not 45-60°)
However, when using a measurement abbreviation, and there is a
space between the digit and the abbreviation, the abbreviation need not
be repeated: 3-6 cu in, 0.75-0.85 cm

Not, Every Christmas holiday arrangements become source of stress for
families.
But, Every Christmas, holiday arrangements become source of stress for
families.

When To Use To, Through, or Hyphen
◦ Use to only when the final digit is not included in the span: 8 to 12
years (12-year-olds not included)
◦ Use through to include the final digit in the span: 25 through 35
years (35 year-olds included)
◦ Hyphens do not indicate whether the last digit is included in the span.
Use a hyphen when the span has been previously defined in the text
or when its definition can be understood from the context: fiscal
year 2000-2001
◦ Use a hyphen with to when the span describes a noun (6.3.1): a 5- to
10-mg dose (but a dose of 5 to 10 mg), a 2- to 4-year span (but a
span of 2 to 4 years)
◦ If the unit of measure changes within the span, do not use a hyphen:
6 months to 2 years (or, ages 6 months through two years)

Dash (—) [AMA 6.3.2]

 Dashes are separators. They are commonly used to separator
interrupting words or phrases from the main sentence. They are used
only when other marks of punctuation—comma, parentheses, colons—
will not serve well.
Three of the seven factors—weight gain, weight loss, and age—
were not associated with the characteristic symptoms.
Hopkins, Nevens, and Reinholdt—these were the physicians on
duty.

 Dashes are typed as two hyphens—no space before, between, or after.
They must be distinguishable from hyphens.
Hyphen (-) [AMA 6.3.1, also see index]

Semicolon (;) [AMA 6.2.2]

 Hyphens are connectors. They are used primary to connect
compound words, prefixes and suffixes: upper-division rank, longterm worth, son-in-law

 Hyphens are typed directly from the keyboard, with no space before or
after.

 Use between independent clauses (sentences) that are closely related



 AMA rules for hyphenation are numerous and detailed. Questions
about hyphenation are best referred to the manual.
Minus Sign ( - )
 Use in statistical copy (e.g., 1 – β ), but do not substitute a minus sign
for a hyphen or dash in text.
 Type as a hyphen with space before and after.
Negative Value Sign ( -)

 Use in statistical copy (e.g., -5°).
 Type as a hyphen with a space before but not after.
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in meaning.
Nurses should escort patients to the examination cubicle; they
should not leave patients to find their way alone.
Use between independent clauses joined with an adverbial conjunction.
The test for streptococcus was positive; however, other tests were
inconclusive.
Use between grammatical items that contain commas within them.
The following positions are open to all applicants: medical
secretary, United Hospital; radiologist, St. Luke’s Hospital; claims
processor, Metro Health Center; and nurse practitioner, Fairview
Clinic.
Use to separate elements (usually publisher and year, or year and
volume) within a bibliographic group in a reference entry.
Norcroft, AM. Calcium and physical function in women over fifty.
Orthop No Am. 1998;11:39-45

5

FORMATTING THE PAPER
For complete word processing guidelines for Microsoft Word 2007, see pages 15-29 of this booklet.
Directions for Word 2003 are be found at www.smumn.edu/tcwrite under "AMA."
Alignment

New Page Start

Always align text at left margin only. To align text, click Format, Paragraph,
Alignment=Left. For details see “Microsoft Word for AMA” in this booklet.

Title page, Abstract, Table of Contents, First page of text, Reference page,
Appendices. DO NOT force a new page by pressing the Enter key repeatedly.
Instead, insert a page break or pres Ctrl+Enter.

Font

Page Numbers and Headers

Times New Roman 12 is most commonly used, but others are available. Keep
font size the same throughout, except for superscripts. For detailed instructions
on setting fonts, see p. 18 of this booklet.

Each page of text should contain a page number at the top right, one-half inch
from the top edge of the paper. Directions are in “Microsoft Word for AMA” in this
booklet.

Superscript For in-text citations and for some statistical and medical
notation, superscripts (and occasionally subscripts) are required.
Superscript: Glover et al9 reported no difference . . .
Subscript: H20

Table of Contents
Directions for formatting the table of contents, if one is required, are found in
“Microsoft Word for AMA” in this booklet.

Indents

Capitalizing Headings

Do not set indentation for First Line Indent. Leave First Line Indent setting at
"none" to prevent headings from being indented. To indent paragraphs, press
the TAB key, which is pre-set for ½ inch. For details see “Microsoft Word for
AMA” in this booklet.

The general rule for Level 1 and 2 headings is to capitalize major words-meaning all words except (a) coordinating conjunctions, (b) articles, and (c)
short prepositions (but caplitalize any work that beings the title). Do not
capitalize the following:
 Coordinating Conjunctions

For direct quotes longer than four lines, set off the quote as a separate
paragraph and indent the entire paragraph as shown in “Microsoft Word for
AMA” in this booklet.

There are seven coordinating conjunctions, and they can be arranged by
their first letters to form the "word" fanboy: for, and, nor, but, or, yet
 Articles

Line Spacing
Leave one double space between all lines—never more, never less (unless your
instructor tells you otherwise)—except within references on the reference page.
To set double spaces before you begin typing, see “Microsoft Word for AMA” in
this booklet.

Articles are those three critical little words--a, an, and the--without which
we can scarcely write a sentence.
 Short Prepositions

Prepositions, like articles, are function words. When paired with nouns,
they identify relationships of position and time, like before sundown,
between you and me, among the trees, and above average. There are
more than 70 common prepositions. Do not capitalize prepositions of
three words or fewer:

If you notice irregular spacing between paragraphs (e.g., three lines instead of
two), refer to “Microsoft Word for AMA” in this booklet.
Margins
Margins on an AMA paper are set at 1 inch on all four sides, unless a journal's
submission guidelines require otherwise. To change margins, r details see p. 19
of this booklet).

as at but by for in of off

on out to up

Level 3 headings (indented on the same line as text) are capitalized only in the
first word and proper nouns.
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CITATIONS and REFERENCES IN AMA STYLE
[AMA 3.1–3.16 (See also 3.13.9 and 3.7)]



IN-TEXT CITATIONS

THE REFERENCE PAGE

[AMA 3.6 (See also 3.7 and 3.13.9)]

[AMA 3.1–3.16.3]

Indicate citations in superscript Arabic numerals (usually at the end of the sentence).
Number them in the order in which they appear in the text. Each citation will retain
its original number whenever it appears in the text.
For directions on creating superscripts see the "Using MSWord for AMA Tasks"
section of this booklet.



Punctuate the text as follows: place commas and periods before numbers; place
colons and semicolons after numbers.



When more than two references occur together [AMA 3.6] ,
~ use a hyphen (no spaces) to separate first and last items in a closed series: 4-8, 15
~ use a comma to separate non-series: 8,10,13



Use Arabic numerals, not superscripted, to correspond to citation numerals in text.



Give full citation (see below) to enable readers to easily retrieve your source.



Generally, every source cited in the text must have an entry on the reference page.
Reference page entries are limited to sources actually cited in the text. Personal
communications (oral, written, and electronic) and articles not accepted for
publication are not included on the reference page. Instead, give a parenthetical
note in the text (see AMA 3.3, and 3.13.8, p. 60).



Pay close attention to spacing following punctuation marks. Follow examples in
manual



Reference content. Each reference entry is divided by periods into bibliographic
groups.

~ use a comma to separate two sequential references: 8,9


If you mention the author's name, use only the last name--no first names, titles, or
initials.



In the case of multiple authors, note the following [AMA p. 45]:

Example (book) Brackets indicate a bibliographic group.

1

2

3

4

#. Sama S, Dolomar P. Obesity: Genetics and Lifestyle. 2nd ed. Berkely, CA:
Valley Press; 1993.

~for two authors or author and a group, use both surnames:
Mehta and Zinn12 studied the effects
Fidleson and the National Institute of Health15 analyzed the
~for more than two authors, use only first author's name followed by et al

Books [AMA 3.12.1–3.12.11] (See example above)
Bibliographic groups appear in the order listed:

Glover et al9 reported no difference . . .


In most cases, place citation numbers at the end of the sentence. However, if you
mention the name of the author/s in text, place the citation immediately after the
name/s. Likewise, if you refer to "a study" or "studies," place the citation
immediately after "studies":
Several studies4,7,10-13 conducted in the United Kingdom . . .

Page Numbers in Citations [AMA 3.6, p. 44]
The APA does not say that page numbers are required with quotations; however, most
instructors require them and some authors include them on occasion even for unquoted
text. Page numbers appear within the superscript citations, as in the following examples.
. . . when children became "physically resistant" to
Two

hospitals4(p4),12(p41)

treatment.2(p8)

1.
2.
3.
4.

Author/s surname and initial/s [3.7]
Title (and subtitle if applicable, preceded by a colon) [3.9.1–3.9.4]
Volume [3.12.6] or edition [3.12.7] if more than one
Publication information
city and state (or country) [3.12.8. and 14.5]
publisher name [3.12.9]
publication date [3.12.10] 3.12.8–3.12.8]

For special circumstances such as chapter, translator, editor, etc. see 3.12.4–3.12.5
(Continued)

reported similar incidents that year.
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Print Journals [AMA 3.11–3.11.15]

Electronic Journals [AMA 3.15 -3.15.12]

Bibliographic groups appear in the order listed:

1. Author/s surname and initial/s [AMA 3.7]
2. Title of article [3.9–3.10] (note formatting)
3. Title of journal, abbreviated [3.11.12] (note formatting)
4. Locator information
year [3.11.13]
volume number [3.11.3 and 3.11.5]
issue number [3.11.3 and 3.11.5–3.11.7
inclusive page numbers [3.11.3–3.11.4]
5. If applicable, give part number, supplement, theme, special edition [3.11.7–3.11.8]
For special circumstances such as no identified author, see 3.11.9–3.11.15

1

For AANA purposes, you should depart from AMA guidelines regarding
electronic references. Sources retrieved from databases are to be treated as
print sources, not electronic sources. Sources retrieved from the Internet
should include URL (Internet address) and access date.

Some of the AMA directions in the “Electronic sources” section below are in lighter
font. If you are a Twin Cities CRNA student, ignore directions in lighter font. If you
have been instructed to follow AMA verbatim, then adhere to all rules below, including
those in lighter font.
AMA directions for online resources require that, in addition to the print information,
you should add the follow for electronic journals:

Note spacing of punctuation in examples.
Example 1

NOTE TO TWIN CITIES STUDENTS

1. DOI, PMID, or URL (Internet address)
~ If both URL and DOI are available, use the DOI instead of URL (AMA p. 65).
~ If both URL and PMID are available, use both, URL listed first (AMA p. 63).
2 Publish date (date posted online) online, if available
3. Update date, if applicable
4. Access date (date you retrieved it), followed by period. Do not give access date
when DOI is available

2

#. Davis JT, Allen HD, Powers JD, Cohen DM. Population requirements for

3

capitation planning in pediatric cardiac surgery. Arch Pediatr Adolesc Med.

4
1996;150(3):257-259.

Example 2: Source with part number
#. Davis JT, Allen HD, Powers JD, Cohen DM. Population requirements for
capitation planning in pediatric cardiac surgery. Arch Pediatr Adolesc Med.
1996;150(3, pt 2):257-259.
Example 3: Source is a supplement
#. Davis JT, Allen HD, Powers JD, Cohen DM. Population requirements for
capitation planning in pediatric cardiac surgery. Arch Pediatr Adolesc Med.
1996;150(3, suppl):257-259.
(The issue number is 3; the abbreviation "suppl" indicates that the source is a
supplement issue.)
Example 4: Theme issue
#. Davis JT, Allen HD, Powers JD, Cohen DM. Population requirements for
capitation planning in pediatric cardiac surgery. Arch Pediatr Adolesc Med.
1996;150(3, theme issue):257-259.

Note spacing of punctuation in the following examples.
Example 1: URL, with online published date and update
#. Davis JT, Allen HD, Powers JD, Cohen DM. Population requirements for
capitation planning in pediatric cardiac surgery. Arch Pediatr Adolesc Med.
1996;150:257-259. http://www.djo.harvard.edu/site.php?url=physicians/0a/671.
Published April 10, 2007. Updated April 1, 2007. Accessed May 29, 2007
Example 2: Source with DOI number
#. Voney G, Biro P, Roos M, Frielingsdorf B, Shafighi M, Wyss P. Interrelation of
peri-operative morbidity and ASA class assignment in patients undergoing
gynaecological surgery. Eur J Obstet Gynecol Reprod Biol. 2007;132(2):220-225.
doi:10.1016/j.ejogrb.2006.04.028.
Example 3: PubMed source with PMID number
#. Moore PA, Cooper GM. Obstetric anaesthetic deaths in context. Curr Opin
Anaesthesiol. 2007;20(3):191-194. PMID:17479019. Accessed June 2, 2007.
Example 4: Source from database, no DOI or PMID
#. Zhan L. Faculty matters. Nurs Educ Perspect. 2007;28(3):118-119. Accessed July
8, 2008.
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 Direct quotes are best used for a specific purpose—for example, if you intend to

General Notes About Electronic Sources
 If only the citation or abstract are available online, and you had to request a
print copy of the article, cite it as a print source, not an electronic source.
 DOIs and PMIDs do not appear on PDF documents, so save or print the
citations from your database search.
 After completing the reference list, check the URLs, DOIs, and PMIDs to make
sure they work.

comment on the author’s word choice or style of expression.

If you find a direct quote to be necessary, follow the AMA guidelines:

 Short quotations are explained in AMA 8.6.1.
 The manual does not say that page numbers are required with quotations;
however, your instructor may prefer them. If you use page numbers, follow the
instructions beginning in the last paragraph on AMA 3.6, p. 44.

To access documents using a DOI or PMID number, type one of the following
addresses into the URL box, followed by the number (AMA p. 64):

 Introduce the source of the quote before presenting the quote itself. If the author's

 DOI documents: http://dx.doi.org/

name is given, place the citation immediately after the author's name rather than at
the end of the sentence.

 PMID documents: http://www.ncbi.min.nih.gov/PubMed/

 AMA 6.6.14 says that quotes longer than 4 lines should be blocked and placed in

For example: http://dx.doi.org/10.1016/j.ejogrb.2006.04.02

reduced type without quotation marks. Blocked generally means that the entire
quote is indented ½ inch (or whatever your normal paragraph indentation is).

DOI number

 Blocked quotes may not be acceptable. Check with your instructor.
Secondary Sources [AMA 3.13.10]
If you read about an original author's work (primary source) in another author's text
(secondary source), you must cite both works as follows (the example is based upon
reading about work by Peller in an article by Givens):
In your text, if you mention the name of the author, give the primary author (Peller).
On your reference page, Give the name of the original author and retrieval information (if
available), followed by the secondary source (Cited by: Givens or Quoted by: Givens) and
retrieval information for secondary source.
Note that the use of secondary sources and abstracts will detract from your scholarship.
Whenever possible, read the complete text of the original author. Reserve secondary
sources to special cases, as when the original text is not available in English. Discuss the
use of secondary sources with your instructor.

AMA HEADINGS [2.8.1-2.8.3 and 22.5.3]
Headings are important organizational and transitional markers. Styles may vary from
journal to journal; however, the AMA provides general guidelines.
LEVEL 1
A Level 1 heading designates a major section of the paper. Type the heading
fully capitalized and boldfaced. Begin the text (or the next heading) one double-space
below the heading, at the left margin, and indented ½ inch.
Level 2
Level 2 headings designate subdivisions of a major section. A Level 2 heading is
typed at the left margin in boldface and lowercase. Capitalize only the first letter of major

DIRECT QUOTATIONS
Direct quotations are generally discouraged in academic writing (other than literary
reviews) for the following reasons:

 Quotations are removed from their original context and may not fit properly in the

words and proper nouns. Paragraph text begins one double-space below the heading, at
the left margin, indented ½ inch. When used to divide a section, at least two headings are
required (a section can't be "divided" into only one subdivision).
Level 3. Level 3 indicates a subsection of a Level 2 subdivision. The heading is

context you provide.

 Sometimes the meaning or intent of the quote is changed by the new context.
 Quoting someone directly provides no indication of how well, or even if, you
understand the material you are quoting. Overuse of quotes therefore can cause
you to lose credibility with your readers.

 Quoting, if not done very skillfully, can break up the flow of your writing. Suddenly

indented ½ inch and followed by a period. Type in boldface and lowercase, capitalizing
only the first letter of major words and proper nouns. The paragraph text begins after the
period, on the same line as the heading. The text "wraps" to the left margin as shown in this
paragraph. As with other levels of headings, there must be at least two Level 3 headings
when they are used to divide a section.

encountering another person’s writing style can be jarring to readers.

 It is your job to summarize and interpret research for the reader. A direct quote
more or less says to the reader: Here, you figure it out.

©The Writing Center, Saint Mary's University of Minnesota, Schools of Graduate & Professional Programs
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Examples From Student Writing

Note the following:







Headings are always bold-faced.
A Level 4 heading exists [AMA 22.5.3]; however, it is rarely used and would be
appropriate only for a very lengthy and complex paper. Check with your
instructor or advisor before using it.
Headings make the paper much easier for the reader to follow. They also help
keep the writer focused and organized, and they make transitions clearer.
The AMA manual provides information about headings in sections 2.8 and
22.5.3.
Headings are more easily formatted if you list them on a separate sheet of paper,
away from the text, where their relationships are clear. After formatting, you can
easily insert them back into the text.

Within the cardiac muscle fibers are dark areas called intercalated discs that function
as a connection between connect two different cardiac muscle fibers, forming a series
with one another.
It is the [T]roponin and tropomyosin regulatory proteins, stimulated by the increased levels
of calcium, which allow the active sites on the actin filament to interact, thus creating
myosin bridges.

ACTIVE AND PASSIVE VOICE [7.3.1]
The AMA says this about active voice (p. 320)
In general, the authors should use the active voice, except in instances in which the
actor is unknown or the interest focuses on what is acted on . . . If the actor is
mentioned in the sentence the active voice is preferred.

ELIMINATING WORDINESS
Wordiness refers to the habit of loading a document with words that don’t contribute to the
purpose or meaning. What causes wordiness? Some writers resort to wordiness because
they’ve been assigned a 500-word paper, but have only 200 words worth of ideas about the
topic, hence the extra words to meet length requirements. Other writers use extra words to
obscure fuzzy or undeveloped thinking. When they’re not sure what they’re talking about,
they try to cover their inadequacies with words. Most readers, however, recognize the ploy.
Writers who rely on verbosity lose credibility with their readers.
Sometimes writers are wordy without realizing it. They habitually employ stock phrases
without considering whether the phrases add meaning. Below are examples of such
phrases. Wordiness is a weakness to watch for when revising. Mark out meaningless or
repetitive phrases.
1. Don’t use more words that you have to.
in this day and age = today
at this point in time = now
2. Don’t say the same thing twice.

Active Voice
Instructors often tell students to write in the active voice. What does this mean? Active
voice emphasizes a subject doing something, as in the following sentence:
Captain Hawes fired the gun.
Passive Voice
By contrast, passive voice emphasizes something done to a subject.
The gun was fired by Captain Hawes.
Passive voice emphasizes a different subject: in the example above, passive voice places
the focus on gun, while active voice places it on Captain Hawes. Passive voice also uses
more words than active voice to express the same idea, thus contributing to the problem of
wordiness. You can reduce the number of words:
The gun was fired.

In the month of November = in November

But then you omit important information—in our example, who fired the gun.

yellow in color = yellow
3. Don’t use words that don’t add meaning.
The fact of the matter is that I’m tired = I’m tired
WORDY

CONCISE

an unexpected surprise ......................... a surprise
at that point in time ................................ then
due to the fact that ................................ because
end result ............................................. result
past history ........................................... history
He is a person who can be trusted ........ He can be trusted.
There are many teens who smoke. ....... Many teens smoke.
two different kinds ................................. two kinds
refer back to .......................................... refer to
surrounded on all sides ......................... surrounded
There is no doubt that he lost. .............. He lost.

Active or Passive Voice?
In general, use the active voice because (a) it reduces wordiness, and (b) it provides more
information in a more direct fashion.
However, use the passive voice when you want to emphasize the receiver rather than the
doer of the action:
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Active:

Tetracycline was increased to 50 mg.
Doctors increased tetracycline to 50 mg.

10

"FLOW": HOW TO IMPROVE IT
What is "flow"? People sometimes use the informal (and imprecise) term flow, as
in "does my paper flow?” when they want to know if readers can follow ideas
easily. This quality of discourse called "flow" (writing professionals refer to it as
coherence) is influenced by a number of factors. Flow, or coherence, cannot be
addressed as a single concept; it needs to be analyzed to identify its underlying
components.
Keep in mind that academic writing is different in a number of ways from less
formal discourse such as personal letters and reflections, newspaper articles,
and advertising brochures. First, of all, academic writing usually involves
complex and abstract concepts, explained thoroughly and objectively. Academic
writing often employs specialized vocabulary requiring definitions or context
clues. In addition, academic writing is idea-dense, which means that a lot of
information is conveyed in a small space. It is also high stakes writing, in that
misunderstandings by readers can be costly. Finally, academic writing must be
understood by a worldwide audience of English readers, in whose countries
another English dialect may prevail. For all these reasons, academic writing
must follow a strict model of Standard Formal English, the model shared by most
academics around the world.
Because of the complex and high stakes characteristics of academic and
professional writing, readers must rely more heavily of the structure of the text to
understand it, text structure that includes consistency, organization, grammar,
transitions, and diction.
Factors That Affect "Flow"
 Consistency. Keep terminology consistent. If you are writing about the
relationship between "company service representatives" and "customers,"
don’t call them "company staff" and "clients" in the next sentence or
paragraph. Keeping the terms consistent throughout the paper helps
readers concentrate on concepts instead of trying to figure out if you are
still referring to the same thing, or why you changed the terms. It's good
to avoid unnecessary repetition, but consistency is not the same as
repetition—or, if you prefer to think of it this way—consistency is "good"
repetition.
 Headings. Headings and subheadings are essential to organization.
They provide a quick overview of content; they establish logical
relationships among sections of the paper and provide transition from one
section to another. Imagine yourself driving through a large foreign city
without road signs marking highways and streets. Readers experience
something similar as they navigate a paper with no headings. Here is the
best part: Headings keep the writer, as well as the reader, organized.
Establishing headings before you write helps keep you focused. For tips
on effective headings, read the "Headings" section of this booklet.
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 Pronouns. Pronouns replace or "point to" words you have used
previously in your text: Students learn more from teachers who inspire
them. If the connections are unclear, the ideas become disconnected. To
avoid pronoun confusion, read "Avoid Vague Pronouns" in this booklet,
and follow up with appropriate sections of the AMA manual.
 Quotations. Quotations disrupt the flow of ideas and mix writing styles. If
you must use a quotation, keep it very short. Avoid quoting complete
sentences and paragraphs. Read the "Quotations" section of this booklet
for do's and don'ts.
 Audience. Disruption to flow occurs when there are gaps in information or
disorganization in presenting it. Gaps and disorganization occur when the
writer forgets the audience. We tend to be egocentric when we compose,
thinking of what we know or intend to say rather than what the reader
needs to know or might misinterpret. Try to read your own paper from an
audience point of view.
 Transitional devices. If you read the second paragraph under the
heading "FLOW: How to Improve It" above, you will see examples of
transitional devices: First of all, . . . In addition, . . . also . . . Finally, . . .
For all those reasons. These transitional words and phrases keep
nudging the reader forward and then, finally, announce a summary
statement, "For all those reasons. . . . " You will find a list of transitional
words and phrases in this booklet under the "Transitions" heading.
Some transitional devices are non-verbal: for example, (a) alphabetized
lists within paragraphs, (b) numbered lists arranged vertically, and (c)
bullet points.
 Organization. When you think about organization, think about levels.
The entire paper has an organization; sections of the paper have
organization; paragraphs have organization; and, yes, sentences have
organization.
1. Overall organization. When you consider the organization of your
paper, ask yourself, What is the most logical way to present this
particular topic?: chronologically? climactically? most-to-least important? cause-and effect? compare-contrast? problem-solution?
myth-and-fact? sequence of steps? reverse order? Remember that
after you decide on an overall organization, you may decide to use
another organizational method within a specific section.
2. Section organization. The organization of a section depends upon
the purpose of the section. Let's take a literature review section as
an example here because many students struggle with the flow of
the literature review. The purpose of most graduate literature
reviews is to synthesize (integrate, interrelate) conclusions of others
to arrive at a more-informed conclusion or to answer a question.

11

Therefore, literature reviews are generally organized thematically:
that is, by subthemes of the big topic. You can determine the
subthemes before you start the research (I want to answer the
question, what factors support independent learning in adults? I
probably need to know about motivations of adult learners, social
characteristics of adult learners, cognitive functioning of adult
learners—so these will be my subheadings). But as you read the
literature, you keep running across another theme you call
"psychological barriers," so you may add or replace a subheading.
Organizing a literature review section by presenting one article
summary after another, instead of thematically, is guaranteed to
confuse your readers (and probably you).
3. Paragraph organization. Not all paragraphs need to be organized
exactly the same way (ho-hum), but most paragraphs should contain
a topic sentence stating the main idea, followed by supporting
statements (examples, illustrations, explanations, and so on). Refer
again to the second paragraph under “Factors That Affect Flow"
above. What do you notice about its organization? Look at another
paragraph organization, this time under the heading "Headings."
 Parallelism. Did you notice that sentence organization was not
addressed under the "Organization" heading? That is because an
important aspect of sentence organization falls into a special category
called parallelism, which refers to grammatical "sameness" within
elements of a sentence. You can read about this under the "Parallelism"
heading in this booklet. Poor parallelism will not go with your flow.
While we are on the subject of sentences as organization, take note that
the standard word order of an English sentence is [subject]+[verb]+[objector-modifier]. For example,
Sue hates fruitcake. Sue [subject] hates [verb] fruitcake
[object].
Ahmed feels frustrated. Ahmed [subject] feels [linking verb]
frustrated [modifier of subject].
Whenever you find yourself with a disorganized sentence, reduce it to its
simplest form: subject+verb+object-or-modifier. If you can't identify those
three elements, rethink the idea and try again. If you identify several
subjects, verbs, and objects or modifiers, you may need more than one
sentence to express the idea.



Wordiness. A section of this booklet is devoted to the problem of
wordiness, and you should read it. Keep in mind that the human brain
can't process more than a few bits of information at a time. When we
read, we "chunk" together bits of information into meaningful ideas.
When you introduce unnecessary words into your presentation, you
place a heavier burden on the reader's ability to process the information:
it's harder to "chunk" together all those extra bits of information (words).
Eventually, the reader loses the flow. Wordiness comes naturally to all
writers--in part because we test out several ways of saying the same
thing, but forget to delete some of them; in part because the words we
write are hard-earned, and we hate to give them up. Learn to locate
unnecessary words. Your readers will thank you. Your flow will be
improved. Your grades will rise.

 Repetition. No doubt previous writing teachers told you not to repeat
yourself. Your teachers forgot to add the word unnecessarily. Repetition
of key words and phrases can enhance flow by helping readers relate
themes and identify patterns. If you need to repeat a key point, do not say
"as stated earlier"; just do it. Your readers know you stated it earlier, and
if they don't, don't remind them that you are repeating yourself. Repetition
can also be useful as a rhetorical device to emphasize a point. If you
doubt that, read Dr. Martin Luther King's "I Have a Dream Speech." You
can find a much humbler example if you go back to the second paragraph
under the “'FLOW': How to Improve It" heading. Does it leave any doubt
that this booklet deals with a specific style of writing?
 Verb tense. Unnecessary or illogical changes in verb tense cause readers
to stop and scratch their heads, wondering where they are in the flow of
time. APA simplifies verb tense choices by insisting on (a) past tense for
the reporting of outcomes, (b) future tense for relating proposed or
expected actions, and (c) present tense for expressing current or ongoing
conditions. So . . .
Past:

Barnes argued . . . Bosso announced . . . Nguen predicted . . .

Future:

I will interview . . . participants will be chosen . . .

Present: Obama

believes . . . the earth revolves . . . women live longer . . .

Note the differencebetween the two statements:

As a group, smokers have a higher rate of heart disease.
As a group, smokers in the study had a higher rate of heart disease.
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AVOIDING VAGUE PRONOUNS
To avoid repetition of nouns, writers use pronouns as substitutes for nouns already named.

 Double check your use of which, that, who. Readers usually associate a pronoun
with the noun closest to it.

Jamison told the woman that his (Jamison's) table was wobbly because his
(Jamison's) son had lopped off its (the table's) leg with his (Jamison's son's) toy
saw.
Pronouns are extremely useful as long as their antecedents (the words they stand for) are
absolutely clear. When pronouns are vague—when their antecedents are not clear—
readers are left to guess at their meanings. Such guessing irritates readers and causes
misinterpretations. (Lawyers know a lot about pronouns!)

Homeless people waited for hours in the cold rain to get into the shelter, which
made many of them ill.
How alarming to think that the shelter made them ill! That's what the sentence suggests,
however. The word which is associated with the noun closest to it: shelter. Recast the
sentence to place which next to the noun it refers to:
To get into the shelter, homeless people waited for hours in the cold rain, which
made many of them ill.

 Make sure that pronouns refer to something specific and that what they refer to
cannot be misunderstood.
Managers wanted new policies immediately, but this didn't happen until June.
What exactly does this stand for in the sentence above? This managers? This policies?
No single antecedent exists for this. The sentence needs to be recast. Here are some
possibilities:

Perhaps it wasn't just the cold rain that made them ill. To include the waiting, recast the
sentence again, this time eliminating which
Waiting in the cold rain for hours to get into the shelter made many of the
homeless people ill.

 Avoid the Great Unnamed.
It was not revealed by the authors why only women were included in the trial.

Managers wanted new policies immediately but didn't get them until June.
Managers wanted new policies immediately, but these new policies weren't
implemented until June.

It seems not to refer to anybody or anything in the sentence. (Actually it refers to the entire
phrase why only women were included in the study, making its use redundant. ) Recast
the sentence:

This, that, these, and those are pronouns frequently used carelessly, leaving readers to
ask, "This what?" "That what?"

 Do not use this, that, these, or those unless the antecedent has already been

The authors did not reveal why they had included only women in the trial.

 Never use you in academic writing.
The study showed that you can reduce the risk of stroke by taking one baby
aspirin per day.

named.

Suddenly this woman rose from her chair and stalked out.
Unless this woman has been introduced to readers in a previous sentence, they will
wonder," What woman?"

The use of you suggests a specific reader, who, even if known, should not be addressed
directly. Such direct forms of address are just too chummy for academic or professional
writing. Recast the sentence:
Research showed that taking one baby aspirin (75mg tablet) per day can reduce
the risk of stroke.

 If you have trouble with vague pronouns, avoid using this, that, these, and those
all alone.
Edwards' boundless optimism creates high expectations on a limited budget. That
worries his supporters.
What worries Edwards' supporters: his optimism, the high expectations, or the budget?
The word that alone doesn't tell us. Use the appropriate term after that. For example,
Edwards' boundless optimism creates high expectations on a limited budget. That
optimism worries his supporters.

 Never use we/us or they/ them unless those pronouns refer to specific
individuals.
We know that people pay attention when their money is at stake.
Who is the we in the sentence above? The writer is including himself and some
unspecified others. Unspecified means vague. The use of we creates another rhetorical
problem: by including all readers, the writer ensures that somebody will disagree. Using we
to mean everyone challenges someone to disagree, thereby creating the opposite effect
intended.
If a work is co-authored, using we to refer specifically to the authors is fine:
We (the other author and I) designed the study to exclude girls between the ages
of 6 and 8 years
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IMPROVING SENTENCE CONSTRUCTION: PARALLELISM
Parallel . . . but
Parallelism means that all sections are grammatically equal or balanced. Consider the
following example:

Johnston hypothesized that with drug X, post-operative recovery would be fast,
respiratory status would improve, and pain control would be better than drug Y.

Whenever Harry has free time, he enjoys sailing, hiking, and he plays basketball.
Remember that old jingle from
Sesame Street?
One of these things
is not like the others . . .
..

The sentence still has problems because the comparison is not clear and the parallel
elements are awkward; so let’s take the sentence a step further:

Whenever Harry has free time, he enjoys
(a) sailing,
(b) hiking,
and
(c) to play basketball.

What is not like the others, of course, is the phrase to play basketball. It is grammatically
unparallel. The sentence would be better written as follows:

Parallel and Improved
Johnston hypothesized that, in comparison to drug Y, drug X would speed postoperative recovery, improve respiratory status, and provide better pain control.
In the last example, each element begins with a simple verb to eliminate the awkward
and repetitious would be construction. Also, the comparison is clarified by placing the
items being compared—the drugs—in the same part of the sentence.

Harry enjoys sailing, hiking, and playing basketball.
That way, each of the three elements is expressed in grammatically parallel form.
Parallel sentences are easier for readers to grasp, and they indicate that you have thought
through carefully what you intend to write. Everyone would understand (though maybe not
appreciate) the sentence about Harry, even if it weren’t parallel. The sentences you write
in your paper, however, are likely to be more complex and carry more sophisticated
messages than Harry likes sailing, and their ideas much more sophisticated, causing
readers to rely more on the grammatical structure.
Here are two examples of sophisticated sentences with parallelism problems:
1. Example 1
Unparallel
The course instructor helped us see the necessity of designing meaningful
curriculum, meeting the required standards, and to keep the human element in
mind.
Parallel
The course instructor helped us see the necessity of designing meaningful
curriculum, meeting the required standards, and keeping the human element in
mind.
2. Example 2
Unparallel
Johnston hypothesized that with drug X, post-operative recovery would be fast,
improved respiratory status, and with better pain control than drug Y.
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WRITING AN ABSTRACT
[2.5 – 2.5.7]

NOTES

The AMA manual provides excellent and detailed guidelines for writing abstracts of several
kinds of documents. Read the sections indicated above before you write your abstract.
Incidentally, the abstract is best written after the paper is completed.

Length
An abstract is less than one page, double-spaced. It is generally one paragraph
ranging in length from 75 to 120 words, but length varies by journal.

Contents










Write a comprehensive summary of the article, including conclusions.
Indicate the purpose and scope of the information contained in the article.
Describe the kinds of sources used (professional literature, observation, interview,
etc.) or methods or procedures, depending upon type of article.
State conclusions, implications, and applications.
Use key words used in the article that will enable database searchers (a) to
discover your work in a keyword search and (b) to decide whether your article is
pertinent to their needs.
Mention nothing in the abstract that is not included in the article.
Be focused: Use specific nouns (e.g., elementary science teachers, not
educators) and active verbs.
Be objective: Summarize, but don’t evaluate or editorialize.
Be concise; every word must count.

Tips for Being Concise










Do not repeat the title in the abstract.
Avoid citing sources if possible.
Use numerals (e.g., 32) rather than words (thirty-two).
Start with the most important statement about the article.
Include only the most important findings.
Do not include examples.
Avoid passive voice when possible (e.g., not similar results were reported by
three researchers . . . , but three researchers reported similar results).
Avoid starting sentences with “it is” and “there are” (e.g., not There were four
studies that showed . . . , but Four studies showed).
Avoid meaningless phrases like This review was undertaken to compare x and
y (instead of This review compares x and y)
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USING MICROSOFT WORD 2007® FOR AMA TASKS
This booklet is not formatted in AMA style.
THE MS WORD® 2007 "DASHBOARD"

OFFICE ICON
opens a menu

QUICK ACCESS TOOLBAR
(can be customized)

RIBBON BAR TABS (there are 7 of them: from the left, Home, Insert, Page Layout, References, Mailings, Review, View)

RIBBON
BAR

RIBBON
BAR

RULER BAR (can be turned on and off in View tab or here )

GENERAL TIPS
The diagram above is to assist you with terminology in this section. For more word processing information, the University Library has Word 2007 manuals for student use. The Writing Center
also offers assistance. Beginners should enroll in a word processing course or workshop.
The feature that most distinguishes MS Word 2007 from earlier versions of Word is the Ribbon Bar. The Ribbon Bar is loaded with features, many of which you will never use, but the features
cannot be changed or customized. However, Word 2007 also has a Quick Access Toolbar that can be customized and moved to a more convenient location.
The directions throughout this booklet are based upon use of the Ribbon Bar because that is what all Word 2007 users have in common. In a special section of this book, however, you will find
directions for customizing and using the Quick Access Toolbar, which can make your work faster and easier. Refer to the table of contents at the beginning of the booklet.

Save yourself some time and frustration by using the keys correctly:

Avoid reader confusion by typing dashes and hyphens correctly:

Backspace and Delete

Dashes and Hyphens

The keyboard has two delete keys: Backspace and Delete. What’s the difference?
 The Backspace key deletes characters and spaces to the left of the cursor (see the
arrow pointing to the left?).
 The Delete key deletes characters and spaces to the right of the cursor .
For example, in the sentence below—where the cursor has been placed after the n
in frustration—pressing the Backspace key twice will erase the n and the o,
whereas pressing the Delete key twice will erase the space and the b.

 Hyphens are used to connect words and parts of words. The hyphen key is located
next to the 0 on the keyboard. Type hyphens with no space before or after (for
example, "a rags-to-riches story" ).
 Dashes are intended to separate words and phrases. To create a dash, type two
hyphens with no space before, after, or between them. Use dashes to indicate an
interruption (e.g., "Students in Group 2—those who received no training—were
least successful at accomplishing the task.")
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Center

Page Breaks

Never center text by tabbing or spacing. If you do, any revisions will throw the text off
center. Use the Centering function of the word processor. It will automatically adjust
centering as you revise. You can center text before or after it is typed. If you center after
typing, you’ll need to highlight the text, then center it. To center text,

Generally, the word processor automatically creates page breaks as your typing spills over
from one page to another. However, at times you need to force a page break: for example,
at the end of the title page or abstract, or before starting the reference page.

Click the Centering icon

( on the Ribbon Bar "Home" tab, Paragraph section)

Do not force a page break by pressing the Enter key repeatedly. This will cause text to
move down the page every time you revise, leading to unsightly gaps between sections.
Instead, use the Page Break function of MS Word as follows
1. On the Ribbon Bar, click the Page Layout tab.
2. In the Page Setup section of the Page Layout tab, click the Breaks
icon as shown at in the diagram below
3. When the Page Breaks menu opens, click the Page option.

1
2
Grammar Check

3

A word of caution about grammar check . . .
The grammar checker can be a useful tool, but it cannot think the way a human does. If you
type something that doesn't fit one of the grammatical patterns stored in the grammar
checker's memory, it will give you an "alert," meaning it can't find a matching pattern. Think
of the alert as a question rather than a command. It is asking, Is this the pattern you really
want? For example, the grammar check usually alerts writers to use of the passive voice,*
because passive voice is usually best avoided. However, it is not necessarily wrong, and
on occasion it may even be preferred to active voice. You must decide to keep, discard, or
modify text that sets off the grammar alert. Don't change something just because the
grammar check highlighted it.

*Passive voice is explained in the AMA manual and in the Writing Center's Introduction to
the AMA 10th booklet available online.

(General Tips, continued)

● SHORTCUT ● SHORTCUT ● SHORTCUT ● SHORTCUT ●
There is a shortcut keyboard option for forcing a page break: Ctrl+Enter (Hold down
the Control key while you press Enter).
To view the page breaks you have entered, see Show/Hide in the section below.

Undo

(Continued)

The Undo icon
is located on the Quick Access Toolbar (see diagram page 2).
Clicking the Undo icon allows you to cancel your last command (if you click Undo once ) or
your last several commands (if you click repeatedly). Make a mistake? Just click Undo!

©The Writing Center, Saint Mary's University of Minnesota, Schools of Graduate & Professional Programs

17

Show/Hide
Irregular Line Spacing Between Paragraphs
The Show/Hide function allows you to see hidden formatting codes—a helpful tool when
you need to correct or modify formatting. To find the Show/Hide icon,
1. On the Ribbon Bar, click the Home tab.
2. In the Paragraph section of the Home tab, find the Show/Hide icon:
3. The Show/Hide icon is a toggle switch: Click once to turn it on, and click again to turn
it off.

Problem
Cutting and pasting between documents can upset the line spacing of your document,
sometimes leaving three lines rather than two between paragraphs, as shown in the
example.

Remedy
The extra line space
cannot be removed by
changing the line spacing
to double. Instead,
change the setting as
follows:
1. Highlight the text you
want to change.
The Show/Hide icon

reveals the following codes:
Symbol
¶
•
….Page Break…

Meaning
Manual line feed (Enter button pressed)
Tab space
Space inserted (space bar)
Manual page break inserted (Ctrl+Enter).

2. From the Home Tab of
the Ribbon Bar, open
the Paragraph box.
3. Set the Before and
After boxes to 0.
(Line Spacing should
already be set at
Double.
4. Click OK to return to
document. You may
need to readjust
spacing.

.
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INITIAL SETUP OF AMA PAPERS

Get started off right! Set up AMA format before you begin typing. You can set formatting just for your current AMA paper, or you can change the default so that the
formatting stays set for future AMA papers. (You can set the default back to MS Word's original settings at any time.) As you become more familiar with Word 2007 for
AMA, you will find shortcuts for some of the tasks described in this section. The directions below allow the option of changing your default settings so you won't
have to keep reformatting each time you start an AMA paper.

1

TYPEFACE (Fonts)

2

The AMA recommends a serif* 12-point typeface.
The University standard is Times New Roman. Keep
typeface the same throughout the paper, even for
page numbers and headers, except where italic and
boldface are indicated by the AMA manual.

To set font,
1. On the Ribbon Bar, click the Home tab.

3

2. In the Font section of the Home tab, click the arrow
in the right corner.
3. When the Font setting window opens, select Times
New Roman, Regular, 12.
Note: Rather than scroll through the list of fonts,
you can type the font name in the box.
4. To set the font for the current paper only, click OK.
5. To keep this font setting for all papers, change the
default as follows:
a. Click the Default button at bottom left of the Font
menu.
b. When the next window opens, click the Yes
button..

4
5

*Serifs are the tiny lines that dangle on the ends of
letters.

©The Writing Center, Saint Mary's University of Minnesota, Schools of Graduate & Professional Programs
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1

2
3

MARGINS

4

Do not try to set margins from the
paragraph menu. Use Page Setup.
AMA papers use margins of 1 inch on all sides unless
otherwise specified by an instructor or by a journal's
submission guidelines.
Many word processor have another default setting, so
you may need to reset your margins as follows:

To set margins,
1. On the Ribbon Bar, click the Page Layout tab.
2. In the Page Setup section of the Page Layout tab,
click the arrow in the right corner.
3. When the Page Setup window opens, select the
Margins tab if not already open.
4. Make sure all four margins are set at 1".

5

5. To make this the setting for all papers, change the
default setting as follows:
a. Click the Default . . . button at bottom left.
b. When the next window opens, click Yes.

©The Writing Center, Saint Mary's University of Minnesota, Schools of Graduate & Professional Programs
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1
PARAGRAPH LAYOUT
ALIGNMENT ● INDENTS ● LINE SPACING

2

Select settings before typing paper.

1. On the Ribbon Bar, click the Page Layout tab.
2. In the Paragraph section of the Page Layout tab,
click the arrow in the right corner.

3

3. When the Paragraph window opens, click the
Indents and Spacing tab if not already open.

a

A

4. Select setting as illustrated by circles "a"
through "e" at right.
(a) AMA text is aligned to the left margin, except
for centered headings and title page. Do not
set alignment at "justified" to make the right
margin even. The right margin should be
ragged.
(b) Use the Tab key to indent paragraphs ½
inch. All indentation, including first line
indent, should be set at 0.

4

b

c

A

d

e

A

A

(c) In AMA lines are double-spaced
throughout—never more, never less—except
for the title and reference pages.
If you find irregular spacing between
paragraphs (usually an extra line), it is
because the "Before" and "After"
spacings are not set at 0 (see 4d in
diagram.
5. To set the alignment, indents, and line spacing
for the current paper only, click OK; but to retain
these the settings for all papers, change the
default setting as follows:

5

a. Click the Default button at bottom left.
b. When the next window opens, click Yes.
 Reference list entries are explained on another
page
 Indented blocked quotes are explained on
another page.
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PAGE NUMBERS AND PAGE HEADERS
The AMA does not specify how page numbers should appear or whether you need a header, so you may want to consult your instructor or journal submission guidelines. The
following examples are common.
1

Insert Page Numbers Top Right
On the Ribbon Bar, click the Insert tab .

2
1.
2.
3.

4.

In the Header & Footer section of the Insert
tab, click the Page Number Icon.
Click arrow to right of Top of Page selection
In the new menu (not shown in diagram),
click the illustration showing page number at
top right of page.
Page number will insert automatically

Insert a Header (less common)

Keep Page Number & Header
Off Title Page
To keep page number and header off title page (if
instructor requests),

2

3
4

1.
2.
3.

4.
5.
6.

Insert page number and header as described
above.
On the Ribbon Bar select the Page Layout
tab.
In the Page Setup section of the Page
Layout table, click the arrow in the right
corner.
When the Page Setup menu appears, select
Layout tab.
Click the Different first page tab to insert a
check.
Click OK at the bottom of the Page Setup
box to close and return to document
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After page number is inserted, type
the header in front of it, followed by
5 spaces. (The header can be the
first word or two of your title, or any
short phrase that identifies the
paper.)Make sure header and page
number are set to Times New
Roman 12 to match font of paper

5
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INDENTATION: LISTS AND BLOCKED QUOTES
For a properly formatted reference page, use Automatic Numbering to create the reference list and adjust the numbers to the left margin as illustrated below.

To create a numbered list,
1.

On the Home tab of the Ribbon Bar, click the
Automatic Numbering icon.

2.

Type the references.

3.

Highlight the references and click the Decrease
Indent icon to move numbers to align at the left
margin of the paper.

If you use lists inside your paper, you can
follow a similar procedure, using either
numbers or bullets. In your paper, however,
you want the list to align with indented
paragraphs, so click the Increase Indent icon
to align the list with indented paragraphs.

Blocked Quotes
Overuse of quotes can weaken a paper. Before you
use a quote, consider what purpose it serves and
whether that purpose can be met in another way. If
you do use a quote, read about their punctuation
and formatting in the APA manual, and remember to
provide a page number with its citation. Usually it is
best to identify the author by name before the
quoting the material.A quote longer than 4 lines should be set off as a separate
paragraph and blocked, or fully indented, ½ inch on the left side.
To indent a blocked quote,
1.
2.
3.

Type the quote as a separate paragraph.
Highlight the paragraph.
Click the Increase Indent tab .

Hyperlinks
URLs typed on the reference page as hyperlinks (text that is blue and underlined
and that activates the URL to connect directly to the Web. If typing the URL creates
a hyperlink:
1. Right click on the hyperlink
2. Select "Remove hyperlink" from the menu that opens .
©The Writing Center, Saint Mary's University of Minnesota, Schools of Graduate & Professional Programs
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"ORPHAN" HEADINGS
(Numbers in brackets indicate corresponding sections of the AMA manual)
For an explanation of AMA heading styles and formatting, see the Writing Center's Introduction to the AMA and Other Writing Tips as well as the AMA manual, pp. 111-115.
Prevent "Orphan" Headings
Headings that stand alone on a line can get separated from
their text when they occur at the bottom of a page. (Turning
on widow/orphan control won't help with headings.) The
following procedure will ensure that headings remain with the
text that follows them.

2
3
4

NOTE: Do not use this command with AMA style 4
indented headings. Use it only for headings that
appears alone on a line.
To prevent heading from separating the their text . . .

5

1. Place the cursor in front of the first letter of the heading (or
before you type the heading).
2. On the Ribbon Bar, click either the Home tab or the Page
Layout tab.
3. In the Paragraph section of the Home tab or Page Layout
tab, click the arrow in the right corner.
4. When the Paragraph menu opens, click the Line and
Page Breaks tab.
5. Click to place a check in the Keep with next box.
6. Click OK.
It's a good idea to set all headings at Keep-with-next, even at
the tops of pages, because headings move as you revise.

1

● SHORTCUT ● SHORTCUT ● SHORTCUT ●
SHORTCUT ●

6

To avoid repeating the steps above every time you type a
title, you can place an icon on the Quick Access toolbar that
completes the steps with a click of a button. See the section
called "Customizing the Quick Access Toolbar."
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HALF-SPACE for Numbers of More Than 4 Digits
2

In science writing, including AMA, numbers contain only decimals—
but no commas.Numbers of more than four digits are grouped by
half-spaces (1/4 em space) rather than commas. Number of 4 digits
contain neither commas nor spaces as the passage below
illustrates:

3

The cumulative estimated number of diagnoses of AIDS
through 2007 in the United States and dependent areas was
1 051 875. Of these, 1 018 428 were diagnosed in the 50
states and the District of Columbia and 32 051 were
diagnosed in the dependent areas. In the 50 states and the
District of Columbia, adult and adolescent AIDS cases
totaled 1 009 220 with 810 676 cases in males and 198 544
cases in females, and 9209 cases estimated in children
under age 13 years.1

4

Half Space for Numbers
To insert a half space,
o Click the cursor between the numbers
where you want the space to occur:
o On the Ribbon Bar click the Insert tab to
open.
o On the far right, click the Symbol icon.
o When the Symbol menu opens, click More
Symbols.
o In the next Symbol Menu, click the Special
Characters Tab.
o Select "1/4 Em Space"
o Click Insert, then Close.
o If a symbol (or any special character) is one
you will use often, you can assign it a
shortcut key—for example Ctrl=X—and
thereafter use the shortcut key to insert that
symbol.

5

6

8

7

REFERENCE

1. HIV/AIDS statistics and surveillance: Basic statistics. Centers for Disease Control and Prevention Web site. http://www.cdc.gov/hiv/topics/surveillance/basic.htm#ddaids. Updated
February 26, 2009. Accessed June 16, 2009.
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CUSTOMIZE AUTOFORMAT SETTINGS
Word 2007is installed with autoformat settings that may be inconvenient for you when you are working on AMA papers. You can easily changes these
autoformat settings to fit your needs. Suggestions are below, but you can customize autoformat as it suits you. (Autoformat changes will be maintained for all
documents until you change Autoformat again.)
For example, many people are
annoyed by the "check-spellingas-you-type" autoformat setting
because it places red underlines
on the screen when the Spell
Check doesn't recognize a word
such as a cited name. The
"check-grammar-as-you-type"
autoformat setting places green
underlines on the screen to
indicated "fragments" when you
place periods after a reference
element.

1

3
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3

You can turn off those
autoformat settings and still
check grammar and spelling
after you have finished the
paper.
2

2

Change an Autoformat Setting
1. Click the Office Icon at the far
top left of the screen .
2. When the Office menu opens,
click Word Options at the
bottom of that menu.
3. When the Word Options menu
opens, click the Proofing
button on the menu at left.
4. When the menu opens, click
off the boxes for Checkspelling-as- you-type and for
Mark-grammar- errors-as-you type. Note that near the bottom
of the menu, you have the
option of saving the new
autoformatting settings just for
the current document (checked
box) or for all documents
(unchecked box).
5. Click OK to close.
©The Writing Center, Saint Mary's University of Minnesota, Schools of Graduate & Professional Programs
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ELECTRONIC COMMENTS
When you send a paper for review, the reviewer can insert comments into the margins of your text. (Electronic comments are standard procedure when Writing Center staff review papers
online.) The comments can be operated a number of ways. These directions will help you manage them. You can also insert comments into your own document.
These instructions are for Microsoft® Word 2007. Comments may appear and function differently in another version of Word.
ARROW

Show Comments in a Document
If a reviewer inserted electronic comments, they
should appear in the right margin of your text. If
not,
1. On the Ribbon Bar, click the Review tab.
2. In the Tracking section of the Review tab, select
"Final Showing Markup" or "Original Showing
Markup" from the first drop-down menu

1

2

Hide Comments in a Document
To hide the comments without deleting them,

1. On the Ribbon Bar, click the Review tab.
2. In the Tracking section of the Review tab, select
either "Final" or "Original" from the first dropdown menu. The comments will be hidden. If you
print, the hidden comments will not show.
Permanently Delete Comments From a
Document
1. Right click inside the comment.
2. Click Delete Comment
Add Your Own Comments to a Document
1. Place the cursor at the insertion point in the text,
or highlight a string of text.
2. On the Ribbon Bar, click the Review tab.
3. In the Comments section of the Review tab, click
the New Comment icon as shown below:

4. Type your comment.

(Continued)
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ELECTRONIC COMMENTS (Continued)
Remove Strikethrough or Double-Underline
Sometimes Writing Center consultants underline
words in your text to suggest that you omit or
replace them, or consultants may double-underline
words to indicate suggested additions or
replacements..
To remove strikethrough or double-underline,
1. Highlight the text that contains strikethrough or
double-underline.
2. Right click inside the highlighted text.
3. When the new menu opens, click Font.
4. When the Font menu opens, click off the check in
the Strikethrough (or Double Underline) box.
5. Click OK.
The strikethrough or double-underline will be
removed, but the words will remain.

Remove Strikethrough or
Double-underline
1. Highlight the text that contains

strikethrough or double-underline.

2

3

4

2. Right click inside the highlighted
text.
3. When the new menu opens, click
Font.
4. When the Font menu opens, click
off the check in the Strikethrough (or
Double Underline) box.

5

5. Click OK.
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DOT LEADERS FOR TABLE OF CONTENTS
AMA provides no guidelines for a table of contents; however, some instructors do require one. Generally a table of contents calls for dot leaders—rows of dots from entries
to their page numbers, like this:

Statement of the Problem ................................................................................................................. 3
Research Questions .......................................................................................................................... 4
Definition of Terms .......................................................................................................................... 5
To make your page numbers line up on the left (and to spare yourself typing hundreds of dots), you must set up dot leaders for your tab stops. Dot leaders automatically
insert dots when you press the tab key, and the dots adjust automatically to give you a straight column of page numbers on the right.
To create a table of contents,
1. Type the title Table of Contents, no boldface, centered, at the top of your page. The table of contents should be double-spaced like the rest of your paper.
2. Open the Tab menu as follows:
a. On the Ribbon Bar, click the Home tab.
b. Open the Paragraph menu (click the arrow inside the paragraph section.
3. In the paragraph menu,
a. Click the Indents and Spacing tab.
b. click Tabs (at bottom left of menu)

4.

When the Tabs menu opens, set dot leaders as shown at right.

a.

Clear All Tab stops (default tab
stays).

b.

Type Tab stop position: 6.5

c.

Select Alignment Right.

d.

Select number 2 dot leader.

e.

CLICK Set. Don't overlook this
step.

f.

Click ok.

NOTE: By setting dot leaders, you turn the
Tab key into a dot leader command. You
cannot now use the Tab key to indent
subheadings in the table of context.
Instead, use the Increase Indent icon as
shown below.

b

c
Start
here

d
e

a
f

NOTE: By setting dot leaders, you have turned the Tab key into a dot leader command. You cannot now use the tab key to indent subheadings in the table of contents. If your
table of contents requires indented subheadings, continue to the next page.
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Indent Subheadings in the Table of Contents
If your table of contents contains subheadings, you cannot indent them with the Tab key, which now inserts dot leaders.
To indent subheadings without dot leaders
1.
2.

Click on or highlight the heading
Click the Increase Indent icon on the Home Tab of the Ribbon Bar.

Statement of the Problem ....................................................................................... 3
Research Questions ............................................................................................... 4
Definition of Terms .................................................................................................. 5
History of the Charter School Movement ................................................................ 9
Urban Changes......................................................................................... 10
Inner City Crises ....................................................................................... 12
Private Initiatives....................................................................................... 13
Legislation ................................................................................................ 15
Indent with Increase Indent icon:
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CUSTOMIZE the QUICK-ACCESS TOOLBAR
A major difference between Word 2003 and Word 2007 is that Word 2003 allowed users to customize any of the toolbar. In Word 2007 the
Ribbon Bar replaces the toolbars, and the Ribbon Bar cannot be changed. However, Word 2007 does allow customization of the location
and the contents of the Quick Access Toolbar.
The figure on page 2 of this booklet shows that the Quick Access Toolbar is located above the Ribbon bar and that it contains only a few
icons:

Add a Command Icon to the Quick Access Toolbar
1. Click on the arrow to the right of the toolbar to open the Customize menu.
2. On the Customize menu, click More Commands . . .

7

3

4
b

5

4
a

3. When the Word Options menu opens (see right) select All Commands.
4. Make a selection from the menu and click the Add>> button .
5. Use the arrow buttons to move the command to the desired position on the toolbar list.
6. Repeat Steps 5 and 6 as necessary.
7. Select the "For all documents (default)" option.

8

8. Click OK to close.

(Continued)
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Remove a Command Icon from the Quick Access Toolbar
1. On the toolbar, right click on the toolbar icon.
2. Select Remove from the Quick Access Toolbar

Some Useful Quick Access Icons for AMA Writers

Opens a new blank document without closing current document.
Allows you to browse for and open an existing document in your folders.
Saves the current document under its existing filename and location
Saves the current document but allow for change of filename or location
Prints document and allows for printer selections
Prevents separation of the heading from the text that follows it
Runs the spell check
Searches for a character, text, or formatting command in current document
Quickly opens the symbol menu

You can add any icon that makes word processing easier for you. Even if the icon already exists on the Ribbon Bar, you may
find it more efficient to use it on the Quick Access Toolbar. Customize it in a way that works for you. It's easy to remove an
icon from the Quick Access Toolbar: just right click on it and select "Remove."

©The Writing Center, Saint Mary's University of Minnesota, Schools of Graduate & Professional Programs

32

Schools of Graduate & Professional Programs
WRITING CENTER
SERVICES



.POLICIES: WHAT WE DO and DON'T

Writing Consultations.



 On campus. Make an appointment. A writing consultant will read
your paper, respond to it, and discuss its strengths and weaknesses
with you. (Please bring your instructor's guidelines for the
assignment, along with the style manual designated for the class.)
Please see our policies below.




 Online. Make an appointment. You can submit a paper (or selected
portions) as an e-mail attachment along with your specific questions
about the paper. You will receive a response by e-mail, or you can
call our toll-free number 1-866-437-2788, ext. 154, to discuss your
questions. Please see our policies below.



Online Writing Center: www.smumn.edu/tcwrite
 Links to some of the best university writing centers in the nation
 Links to information about various forms of academic writing
 Templates for APA papers in your program.
 ESL Information. Students whose native language is not English
will find links to “English as a Second Language” resources.
 Guide to avoiding plagiarism
 Guide to quoting and paraphrasing
 Guide to evaluating research sources



ESL Coaching. Students whose native language is not English can
develop their English writing and speaking skills.



SSVC Workshops. Each term the Writing Center offers workshops on
a variety of writing-related topics such as punctuation, APA source
citations, word processing, resume writing, and PowerPoint

We help you become a better writer. We won’t fix your paper for you;
but we'll help you improve it and, in the process, help you develop as a
writer.
You may have up to 1 hour per week of free consultation as
appointments are available. You may have up to two visits per paper.
We do not edit or proofread papers. The Writing Center performs an
instructional service, not an editing service. Editing focuses attention on
the paper rather than the writer. Editing is often equated with
proofreading—that is, finding and fixing all the “errors” in the paper. At
the Writing Center, you will participate fully by setting your own writing
objectives, discussing feedback, and revising your paper. We will help
you identiry error patterns and teach you to recognize them and correct
them.
presentations. The registration fee for all workshops is $50. For a
schedule, descriptions, and registration, go to the Writing Center’s Web
site www.smumn.edu/tcwrite.
Students who have questions should contact the Writing Center, 612725-5154 or tcwrite@smumn.edu.



Word Processing Instruction. Microsoft Word® 2007 and 2010 for
Windows XP® and Windows 7 for PC users. Coming soon: Microsoft
Word® 2008 and 2011 for Mac users



Questions. We will be happy to answer questions about APA, AMA,
grammar, punctuation, or usage.

Writing Center consultations are free.

Make your own appointment from our Web site at
www.smumn.edu/tcwrite
(See Make an Appointment)
If you need assistance call 612-728-5154
(toll free 1-866-437-2788, ext. 154)
or e-mail tcwrite@smumn.edu
We are located in LaSalle Hall 128 (just across from the library)
Hours are posted on our Web site.
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wordiness, avoid, 12
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Headings, preventing orphans, 24
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Hyphen, 5
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Line spacing, irregular, 18
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change default settings, 19
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customize Quick Access toolbar, 31
dot leaders, 29
font (typeface), 19
general tips, 16–18
grammar check, 17
half-space, 25
headings, prevent orphans, 24
hyperlinks, 23
irregular line space, 18
margins, 20
numbered lists, 23
page breaks, 17
page numbers, 22
paragraph set-up, 21
quotations, blocked, 23
table of contents, 29
Minus Sign, 5
Negative value sign, 5
Numbered lists, 23
Numbers, half-space, 25
Organization, 11
Page breaks, 17
Page numbers, 22
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Paragraph set-up, 21
Parallelism, 14
Print Journals, 8
Pronouns, avoiding errors, 13
Punctuation, 3–5
apostrophe, 3
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commas, 3
dash, 5
hyphen, 5
hyphens & digit spans, 5
minus sign, 5
negative value sign, 5
semicolon, 5
Quotations, blocked, 23
Quotations, direct, 9
Reference page, 9
books, 7
electronic journals, 8
electronic sources, 9
print journals, 8
secondary sources, 9
Reference page, format, 23
Repetition, 12
Secondary sources, 9
Sentence structure
parallelism, 14
Table of contents, how to format, 29
Transitional devices, 11
Verb tense, 12
Word Processing Tips, 16–18
Wordiness, reducing, 10
Writing Center, about, 33
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